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1	 A quick look

Your wireless router

Package contents

NOTES:

•	If any of the items is damaged or missing, contact ASUS for 
technical inquiries and support, Refer to the ASUS Support 
Hotline list at the back of this user manual.

•	Keep the original packaging material in case you would 
need future warranty services such as repair or replacement.

	RT-N56U Wireless Router		    Network cable (RJ-45)

	Power adapter			     Quick Start Guide

	Support CD (Manual, utility software)	   Warranty card

1 USB LED
 �Off: No power or no physical connection.
  �On: Has physical connection to USB devices.
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2 LAN LED
  �Off: No power or no physical connection.
  �On: Has physical connection to a local area network (LAN).

3 WAN LED
  �Off: No power or no physical connection.
  �On: Has physical connection to a wide area network (WAN).

4 5GHz LED / 2.4GHz LED
  Off: No 5GHz or 2.4GHz signal.
  On: Wireless system is ready.
  �Flashing: Transmitting or receiving data via wireless connection.

5 Power LED
  Off: No power.
  On: Device is ready.
  Flashing slow: Rescue mode
  �Flashing quick: WPS is processing.

6 USB 2.0 ports
Insert USB 2.0 devices such as USB hard disks or USB flash drives into these ports.
Insert your iPad’s USB cable into one of these ports to charge your iPad. 

7 Reset button
This button resets or restores the system to its factory default settings.

8 LAN 1 ~ 4 ports
Connect network cables into these ports to establish LAN connection.
  Yellow LED: 1000Mbps connection.
  �Green LED: 10Mbps/100Mbps connection.
  Flashing: Transmitting or receiving data via wired connection.

9 WAN (Internet) port
Connect a network cable into this port to establish WAN connection.
  �Yellow LED: 1000Mbps connection.
  �Green LED: 10Mbps/100Mbps connection.
  Flashing: Transmitting or receiving data via wired connection.

10 Power (DC-In) port
Insert the bundled AC adapter into this port and connect your router to a power 
source.

11 WPS button
This button launches the WPS Wizard.
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Mounting placement

NOTES:	

•	Use only the adapter that came with your package. Using 
other adapters may damage the device.

•	Specifications: 
 
 
 
 
 
 
 

DC Power adapter DC Input: �+19V with max 1.58A current;  
+12V with max 2A current

Operating 
Temperature

0~40oC Storage 0~70oC

Operating 
Humidity

50~90% Storage 20~90%

To mount the wireless router into 
its stand:
1.	Locate the two mounting holes at 

the bottom of the wireless router.

2.	Latch the stand’s two mounting 
hooks to the wireless router’s 
mounting holes.

3.	Slide the wireless router to 
direction of the arrow to secure it 
to its stand.

2
2

3
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2	 Creating your network

Positioning your router

For the best wireless signal transmission between the wireless 
router and the network devices connected to it, ensure that you:

�•	 Place the wireless router in a centralized area for a maximum 
wireless coverage for the network devices.

•	 Keep the device away from metal obstructions and away 
from direct sunlight.

•	 Keep the device away from 802.11g or 20MHz only 
Wi-Fi devices, 2.4GHz computer peripherals, Bluetooth 
devices, cordless phones, transformers, heavy-duty motors, 
fluorescent lights, microwave ovens, refrigerators, and other 
industrial equipment to prevent signal interference or loss.

•	 For the best front-to-rear coverage, place the wireless router 
in an upright position.

•	 For the best up-and-down coverage, place the wireless router 
in an inclined position.

•	 Always update to the latest firmware. Visit the ASUS website 
at http://www.asus.com to get the latest firmware 
updates.
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What you need

To set up your network, you need one or two computers that 
meet the following system requirements:
	 •	� Ethernet RJ-45 (LAN) port (10Base-T/100Base-TX/

1000BaseTX)

	 •	 IEEE 802.11a/b/g/n wireless capability

	 •	 An installed TCP/IP service

	 •	� Web browser such as Internet Explorer, Firefox, Safari, or 
Google Chrome

NOTES:	

•	If your computer does not have built-in wireless capabilities, 
you may install an IEEE 802.11a/b/g/n WLAN adapter to 
your computer to connect to the network.

•	With its dual band technology, your wireless router supports  
2.4GHz and 5GHz wireless signals simultaneously. This 
allows you to do Internet-related activities such as Internet 
surfing or reading/writing e-mail messages using the 2.4GHz 
band while simultaneously streaming high-definition audio/
video files such as movies or music using the 5GHz band.

•	If you are using only one computer with single band  
IEEE 802.11b/g/n WLAN adapter, you will only be able to 
use the 2.4GHz band.

•	If you are using only one computer with dual band  
IEEE 802.11a/b/g/n WLAN adapter, you will be able to use 
the 2.4GHz or 5GHz band.

•	If you are using two computers with both 
IEEE 802.11a/b/g/n WLAN adapters, you will be able to use 
both 2.4GHz and 5GHz bands simultaneously.

•	The Ethernet RJ-45 cables that will be used to connect the 
network devices should not exceed 100 meters.
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Setting up your wireless router

Wired connection

IMPORTANT!

•	Use wired connection in setting up your wireless router to 
avoid possible setup problems due to wireless uncertainty.

•	Before setting up your ASUS wireless router, do the 
following:

	 •	�If you are replacing an existing router, disconnect it from 
your network.

	 •	�Disconnect the cables/wires from your existing modem 
setup. If your modem has a backup battery, remove it as 
well. 

	 •	Reboot your computer (recommended).

NOTE:	 Your wireless router has an integrated auto-crossover 
function, so use either straight-through or crossover cable for 
wired connection.

Modem

1

2

3

4

To set up your wireless router via wired connection:
1.	 Insert your wireless router’s AC adapter to the DC-In port and 

plug it to a power outlet.
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2.	Using the bundled network cable, connect your computer to 
your wireless router’s LAN port.

IMPORTANT!  Ensure that the LAN LED is blinking.

3	 Using another network cable, connect your modem to your 
wireless router’s WAN port.

4.	 Insert your modem’s AC adapter to the DC-In port and plug it 
to a power outlet.

Wireless connection

Modem

1

2

3

To set up your wireless router via wired connection:
1.	 Insert your wireless router’s AC adapter to the DC-In port and 

plug it to a power outlet.

2	 Using the bundled network cable, connect your modem to 
your wireless router’s WAN port.

3.	 Insert your modem’s AC adapter to the DC-In port and plug it 
to a power outlet.

4.	 Install an IEEE 802.11a/b/g/n WLAN adapter on your 
computer.
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NOTES:	

•	For details on connecting to a wireless network, refer to the 
WLAN adapter’s user manual.

•	To set up the security settings for your network, refer to the 
section Setting up the wireless security settings in this 
user manual.

Before you proceed

A.	 Disable the proxy server, if enabled.

Windows® 7
1.	�Click Start > Internet 

Explorer to launch the 
browser.

2.	Click Tools > Internet 
options > Connections tab > 
LAN settings.

NOTE:	 Before configuring your wireless router, do the steps 
described in this section for your host computer and network 
clients.
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3.	�From the Local Area 
Network (LAN) Settings 
screen, untick Use a 
proxy server for your 
LAN.

4.	Click OK when done.

MAC OS
1.	�From your Safari 

browser, click Safari 
> Preferences > 
Advanced > Change 
Settings...

2.	�From the Network 
screen, deselect FTP 
Proxy and Web Proxy 
(HTTP).

3.	Cllick Apply Now 
when done.

NOTE:	 Refer to your browser's help feature for details on 
disabling the proxy server.
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3.	To obtain the iPv4 IP 
settings automatically, tick 
Obtain an IP address 
automatically. 

	 To obtain the iPv6 IP 
settings automatically, tick 
Obtain an IPv6 address 
automatically. 

4.	Click OK when done.

B.	� Set the TCP/IP settings to automatically obtain an 
IP address.

Windows® 7
1.	Click Start > Control Panel 

> Network and Internet 
> Network and Sharing 
Center > Manage network 
connections.

2.	Select Internet Protocol 
Version 4 (TCP/IPv4) or 
Internet Protocol Version 
6 (TCP/IPv6), then click 
Properties.
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MAC OS
1.	Click the Apple icon  

located on the top left of 
your screen.

2.	Click System 
Preferences > Network 
> Configure...

3.	From the TCP/IP tab, 
select Using DHCP in 
the Configure IPv4 
dropdown list.

4.	Cllick Apply Now when 
done.

C.	 Disable the dial-up connection, if enabled.

Windows® 7
1.	�Click Start > Internet 

Explorer to launch the 
browser.

2.	Click Tools > Internet options 
> Connections tab.

3.	� Tick Never dial a connection.

4.	Click OK when done.

NOTE:	 Refer to your operating system’s help and support 
feature for details on configuring your computer’s TCP/IP 
settings.

NOTE:	 Refer to your browser's help feature for details on 
disabling the dial-up connection.



16

3	� Configuring via the web GUI
Logging into the web GUI

Your ASUS Wireless Router comes with an intuitive web graphics 
user interface (GUI) that allows you to easily configure its various 
features through a web browser such as Internet Explorer, 
Firefox, Safari, or Google Chrome.

To log into the web GUI:
1.	On your web browser such as Internet Explorer, Firefox, 

Safari, or Google Chrome, manually key in the wireless 
router’s default IP address: 192.168.1.1

2.	On the login page, key in the 
default user name (admin) 
and password (admin).

NOTES:	

•	For your network clients, ensure that you set the TCP/IP 
settings to obtain IP addresses automatically, disable the 
proxy server settings, disable the dial-up settings, and cancel 
the dial-up connection.

•	For more details, refer to the section Before you proceed 
in this user manual.
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3.	The wireless router’s web GUI launches. Use the web GUI to 
configure various wireless settings.
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2.	The wireless router automatically detects if your ISP 
connection type is Dynamic IP, PPPoE, PPTP, L2TP, and 
Static IP. Key in the necessary information for your ISP 
connection type.

IMPORTANT!	 Obtain the necessary information about your 
Internet connection type from your ISP.

Setting up the Internet connection

NOTE: 	 When setting the Internet connection for the first 
time, press the Reset button on your wireless router to reset 
it to its factory default settings.

Quick Internet Setup (QIS) with auto-detection

The Quick Internet Setup (QIS) function guides you in quickly 
setting up your Internet connection.

To use QIS with auto-detection:
1.	Launch a web browser such as Internet Explorer, Firefox, 

Safari, or Google Chrome.
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NOTES:

•	The auto-detection of your ISP connection type takes place 
when you configure the wireless router for the first time or 
when your wireless router is reset to its default settings.

•	If QIS failed to detect your Internet connection type, click 
Skip to manual setting (see the screen capture in step 1) 
and manually configure your connection settings.

•	If QIS failed to launch automatically, manually launch your 
wireless router's web GUI to access the QIS page. To do this, 
follow these steps:

	 •	On your web browser, key in http://192.168.1.1

	 •	�On the login page, key in the default username admin 
and password admin.

	 •	�Click GO in the Quick Internet Setup field under 
Internet status in the Network Map page.

3.	 Internet connection setup is done. 
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	 Select your next preferred task from any of these options:

	 		  �1.  �Going to Internet: Click to start surfing the Internet 
or do Internet-related activities such as chat, or read/
write e-mail messages.

			�   2.   �Advanced Setting page: Click to go to the wireless 
router’s Advanced Setting page and configure more 
advanced wireless settings.

			�   3.   �Add to Favorites: Click to go add the router’s web 
interface to your Favorites.

NOTES:

•	Ensure that you use a wireless LAN adapter with WPS 
function on your network clients.

•	Windows® operating systems and wireless LAN cards/
adapters that support WPS: 
 

OS Support Wireless Adapter Support

Windows Vista 32/64 
Windows 7 32/64 
Windows 2008

ASUS/Intel wireless LAN card (except 
WL-167g and WL-160W) 
ASUS WL-167g v2 driver v.3.0.6.0 or 
later 
ASUS WL-160N/WL-130N driver 
v.2.0.0.0 or later

Windows XP SP2/SP3 
Windows 2003 32-bit 
SP2/SP3

ASUS/Intel wireless LAN card (not 
support WL-167g and WL-160W) 
ASUS WL-167g v2 driver v.1.2.2.0 or 
later 
ASUS WL-160N/WL-130N driver 
v.1.0.4.0 or later

Windows XP/2003 64-bit 
Windows XP 32-bit SP1/ XP 
32-bit 
Windows 2003 32-bit SP1 / 
2003 32-bit 
Windows 2000 SP4

ASUS wireless LAN card with ASUS 
WLAN Utility 
ASUS WL-167g v2 driver v.1.2.2.0 or 
later 
ASUS WL-160N/WL-130N driver 
v.1.0.4.0 or later

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Wi-Fi Protected Setup (WPS)

WPS (Wi-Fi Protected Setup) allows you to set up a secure and 
protected wireless network easily.
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2.	Follow the onscreen instructions to complete the wireless 
network setup.

IMPORTANT!	 Obtain the necessary information about your 
Internet connection type from your ISP.

To use WPS:
1.	 In the WPS field, click the red button to launch the WPS 

Wizard.

NOTE:	 You may also press the WPS button on your wireless 
router to launch the WPS Wizard.
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Setting up the wireless security settings

To protect your wireless network from unauthorized access, you 
need to configure its security settings.

To set up the wireless security settings:
1.	Key in 192.168.1.1 on your web browser.

2.	On the login screen, key in the default user name (admin) 
and password (admin), then click OK. The wireless router’s 
web GUI launches.

3.	On the Network Map screen, select the System status icon  
to display the wireless security settings such as SSID, security 
level, and encryption settings.

NOTE:	 You can set up different wireless security settings for 
2.4GHz and 5GHz bands. 

2.4GHz security settings
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5GHz security settings

4.	On the Wireless name (SSID) field, key in a unique name 
for your wireless network.

5.	From the Security Level dropdown list, select the encryption 
method for your wireless network.

IMPORTANT!	 The IEEE 802.11n standard prohibits using 
High Throughput with WEP or WPA-TKIP as the unicast cipher. 
If you use these encryption methods, your data rate will drop 
to IEEE 802.11g 54Mbps connection.

6.	Key in your security passkey.

7.	Click Apply when done.
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Managing your network clients
To manage your network clients:
1.	Launch the wireless router’s web GUI.

2.	On the Network Map screen, select the Client Status icon 
to display the information about your network clients.

3.	 In the Priority field under the Client List, you can set the 
priority packet for each client as Normal, High, or Low.

NOTE:	 You can also delete the priority settings from 
Advanced Setting > WAN > QoS tab.

4.	To block a client’s access to your network, select the client 
and click Block.

	 To restore a client’s access to your network, select the client in 
the Blocked client list and click Unblock.

NOTE:	 You can also delete the MAC filter from Advanced 
Setting > Firewall > MAC Filter tab.
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NOTE:	 To use this feature, you need to plug a USB storage 
device, such as a USB hard disk or USB flash drive, to the USB 
2.0 port on the rear panel of your wireless router. Ensure that 
the USB storage device is formatted and partitioned properly. 
Refer to the Plug-n-Share Disk Support List at  
http://event.asus.com/networks/disksupport

IMPORTANT!	 You first need to create a user account to 
allow other network clients to access the USB device. For 
more details, refer to the section Sharing files from a USB 
storage device in this user manual.

To monitor your USB device:
1.	Launch the wireless router’s web GUI.

2.	On the Network Map screen, select the USB Disk Status 
icon to display the information about your USB device.

Monitoring your USB device

The ASUS Wireless Router provides two USB 2.0 ports for 
connecting USB devices such as a USB storage device and USB 
printer, to allow you to monitor the working environment, share 
files, and printer with clients in your network.
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3.	On the UPnP Media Server field, click GO to allow UPnP 
(Universal Plug and Play) devices such as PS3 to access the 
multimedia files in your USB disk.

NOTE:	 For more details, refer to the next section Using 
your router as a UPnP Media Server in this user manual.

4.	On the AiDisk Wizard field, click GO to set up an FTP server 
for Internet file sharing.

NOTES:

•	For more details, refer to the section Using AiDisk for an 
FTP Server and Network Neighborhood setup in this 
user manual.

•	On USB External HDD/Flash disk:

	 •	�The wireless router works with most USB HDDs/Flash disks 
(up to 2TB size) and supports read-write access for FAT16, 
FAT32, EXT2, EXT3, and NTFS.

	 •	�To safely remove the USB disk, launch the web GUI 
(http://192.168.1.1), then in the Network Map page > 
External USB disk status > Safely Remove disk field, 
click Remove.

	 •	�Incorrect removal of the USB disk may cause data 
corruption.
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Using your router as a UPnP Media Server

Your wireless router allows UPnP (Universal Plug and Play) 
multimedia devices, such as PS3 and XBox 360, to access 
multimedia files from the USB disk connected to your wireless 
router.

NOTE: Before using the UPnP Media Server function, install a 
wireless adapter on your UPnP device.

To use your router as a UPnP Server:
1.	Click UPnP Media Server from the navigation menu at the 

left side of your screen.

2.	Select Enabled. Your wireless router is now ready to share 
the media files stored in the USB disk.

NOTE: For details on connecting a UPnP device to the wireless 
router and accessing the media files on the USB disk, refer to 
the UPnP device’s user manual.

IMPORTANT! For details on sharing files/contents from a USB 
disk, refer to the section Sharing files from a USB device on 
this user manual.



28

Using AiDisk for an FTP Server and Network 
Neighborhood setup

AiDisk allows you to set up an FTP server and share the content 
of a USB disk to the clients in your network.

NOTE:	 Before using AiDisk, ensure that you have inserted a 
USB disk into the USB port of your wireless router.

To use AiDisk:
1.	Click AiDisk from the navigation menu at the left side of 

your screen.

2.	From the Welcome to AiDisk wizard screen, click Go.
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3.	Select the access rights that you want to assign to the clients 
accessing your shared data.

4.	To create your own domain for your FTP site via the ASUS 
DDNS services, select I will use the service and accept the 
Terms of service and key in your domain name. 

5.	Click Next to finish the setup.
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5.	When done, click Finish.

6.	To access the FTP site that you created, launch a web browser 
or a third-party FTP client utility and key in the ftp link  
(ftp://<domain name>) you have previously created.
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Managing EZQoS Bandwidth

EzQoS Bandwidth Management allows you to set the 
bandwidth priority and manage the network traffic.
To set up the bandwidth priority:
1.	Click EzQoS Bandwidth Management from the navigation 

menu at the left side of your screen.

NOTE: Manually key in the uplink speed to prevent the router 
from detecting the wrong uplink speed from an unstable 
network.
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2.	Click each of these four applications to set the bandwidth 
priority:

Icon Description

Gaming Blaster
The router handles gaming traffic at first priority.

Internet Application
The router handles the e-mail, web browsing and other Internet 
applications traffic at first priority.

FTP
The router handles at first priority the traffic of downloading/
uploading data to/from the FTP server.

Voip/Video Streaming 
The router handles the audio/video traffic at first priority.

3.	Click Save to save the configuration settings.
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Configuring the Advanced settings

Advanced Setting allows you to configure the advanced features 
of your wireless router.

Setting up the DHCP Server

You may enable the DHCP Server function in your wireless 
router so your network clients can automatically obtain IP 
addresses from your wireless router.

NOTE:	 The ASUS Wireless Router can support up to 253 IP 
addresses for your network.

To set up the DHCP server:
1.	Click Advanced Setting from the navigation menu at the 

left side of your screen.

2.	Under the LAN menu, click DHCP Server.
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3.	 In the Enable the DHCP Server? field, tick Yes.

4.	 In the IP Pool Starting Address field, key in the starting IP 
address.

5.	 In the IP Pool Ending Address field, key in the ending IP 
address.

6.	 In the Lease Time field, key in the time that the IP addresses 
expire and the wireless router automatically assigns new IP 
Addresses for the network clients. 

IMPORTANT!

•	For the IP Pool Starting and Ending IP addresses, we 
recommend that you use:

	 •   �IP address: 192.168.1.xxx (xxx can be any number 
between 2 and 254)

•	IP Pool Starting Address should not be greater than the IP 
Pool Ending Address.
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To upgrade the firmware:
1.	Click Advanced Setting from the navigation menu at the 

left side of your screen. 

2.	Under the Administration menu, click Firmware Upgrade.

3.	 In the New Firmware File field, click Browse to locate the 
new firmware on your computer.

4.	Click Upload. The uploading process takes about three 
minutes.

Upgrading the firmware

NOTE:	 Download the latest firmware from the ASUS 
website at http://www.asus.com

NOTE:	 If the upgrade process fails, the wireless router 
automatically enters the rescue mode and the power LED 
indicator at the front panel flashes slowly. To recover or 
restore the system, use the Firmware Restoration utility. 
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Restoring/Saving/Uploading settings

To restore/save/upload the settings:
1.	Click Advanced Setting from the navigation menu at the 

left side of your screen. 

2.	Under the Administration menu, click Restore/Save/Upload 
Setting.

3.	Select the tasks that you want to do:

	 •	� To restore to the default factory settings, click Restore, 
and click OK in the confirmation message.

	 •	� To save the current system settings, click Save, and click 
Save in the file download window to save the system file 
in your preferred path.

	 •	� To restore previous system settings, click Browse to 
locate the system file that you want to restore, then click 
Upload.
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Sharing files from a USB storage device

Creating a user account

You need to create user accounts before you can share the files 
or data in the USB storage device.

To create a user account:
1.	Click Advanced Setting > USB Application from the 

navigation menu at the left side of your screen. 

2.	Click Share with account, and click OK to enable the 
sharing feature.

3.	Click the Add account icon .
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4.	 In the Account and Password fields, key in the name and 
password of the client/computer in your network. Retype the 
password to confirm. Click Add to add the account to the 
list.

Assigning access rights
To assign access rights:
1.	Click Advanced Setting > USB Application from the 

navigation menu at the left side of your screen.

2.	Select the account that you want to assign access rights to.
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3.	From the list of file folders, select the type of access rights 
that you want to assign for specific file folders:

	 •	 �R/W: Select this option to assign read/write access for a 
specific file folder.

	 •	� R: Select this option to assign read only access for a 
specific file folder.

	 • 	� No: Select this option if you do not want to share a 
specific file folder.

4.	Click Apply to apply the changes.

5.	From the Miscellaneous setting tab, set the Work Group to 
WORKGROUP to enable all computers within WORKGROUP 
to access the wireless router’s USB storage device.

6.	Launch My Network Place from a computer connected to 
the wireless router. Click view work group computers to 
view the wireless router in the Workgroup category. All files 
on the USB storage device are now shared to computers in 
your network.

Sharing files via the FTP server

The ASUS Wireless Router enables you to share files from your 
USB storage device via the FTP server with computers in LAN or 
through the Internet.

IMPORTANT!	 To use this feature, you need to insert a 
USB storage device, such as a USB hard disk or USB  flash 
drive, to the USB2.0 port on the rear panel of your wireless 
router. Ensure that the USB storage device is formatted and 
partitioned properly. Refer to the ASUS website at  
http://www.asus com for the HD file system support table.

NOTE:	 Ensure that you safely remove the USB disk. Incorrect 
removal of the USB disk may cause data corruption.
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To share files via the FTP server:
1.	Ensure that you have set up your FTP server through AiDisk.

NOTE:	 For more details, refer to the section Using AiDisk 
for an FTP Server and Network Neighborhood setup in 
this user manual.

2.	Enable the DDNS service for FTP server access. To do this, 
follow these steps:

	 a.	� From the navigation menu, click Advanced > WAN > 
DDNS tab.

	 b.	 In the Enable the DDNS Client? field, tick Yes.

	 c.	� Key in your User Name or E-mail Address and 
Password or DDNS key.

	 d.	� Key in your Host name. The format should be  
xxx.asuscomm.com, where xxx is your host name.

	 e. When done, click Apply.

3.	From the navigation menu, click Advanced Setting > USB 
Application > FTP Share tab and select the account that 
you want to assign access rights to.
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4.	From the list of files/folders, select the type of access rights 
that you want to assign for specific files/folders:

	 •	� R/W: Select this option to assign read/write access for a 
specific file/folder.

	 •	� W: Select this option to assign write only access for a 
specific file/folder.

	 •	� R: Select this option to assign read only access for a 
specific file/folder.

	 • 	� No: Select this option if you do not want to share a 
specific file/folder.

5.	Click Apply to apply the changes.

6.	To access the FTP server, key in the ftp link  
ftp://<hostname>.asuscomm.com and your user name 
and password on a web browser or a third-party FTP utility.
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Setting up your network printer

Use the Network Printer Setup utility to set up a USB printer on 
your wireless router and allow network clients to access the USB 
printer.

NOTES:

•	To check if your USB printer is compatible with your ASUS 
wireless router, refer to the Plug-n-Share Disk Support List at  
http://event.asus.com/networks/disksupport

•	The wireless router's printer server function is not supported 
on Windows® 2000.

To set up your USB Printer:
1.	Run the ASUS Wireless Utilities from the support CD, then 

click Run Network Printer Setup Program.
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2.	Follow the onscreen instructions to set up your hardware, 
then click Next.

3.	Wait for a few minutes for the initial setup to finish. Click 
Next.
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4.	Click Finish to complete the installation. 

5.	Follow the Windows® OS instructions to install the printer 
driver.
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6.	After the printer’s driver installation is completed, network 
clients can now use the printer.
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4	 Using the utilities
NOTES:	

•	Install the wireless router's utilities from the bundled support 
CD. 

•	If Autorun is disabled, run setup.exe from the root directory 
of the support CD.

Device Discovery

Device Discovery is an ASUS WLAN utility that detects an ASUS 
wireless router device, and enables you to configure the device.

To launch the Device Discovery utility:
•	 From your computer’s desktop, click  

Start > All Programs > ASUS Utility > RT-N56U Wireless 
Router > Device Discovery.

NOTE:	 When you set the router to Access Point mode, you 
need to use Device Discovery to get the router’s IP address.
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Firmware Restoration

Firmware Restoration is used on an ASUS Wireless Router that 
failed during its firmware upgrading process. It uploads the 
firmware that you specify. The process takes about three to four 
minutes.

To launch the rescue mode and use the Firmware 
Restoration utility:
1.	Unplug the wireless router from the power source.

2.	Hold the Reset button at the rear panel and simultaneously 
re-plug the wireless router into the power source. Release the 
Reset button when the Power LED at the front panel flashes 
slowly, which indicates that the wireless router is in the rescue 
mode.

3.	Use the following to set up your TCP/IP settings:

	 IP address: 192.168.1.x

	 Subnet mask: 255.255.255.0

4.	From your computer’s desktop, click  
Start > All Programs > ASUS Utility RT-N56U Wireless 
Router > Firmware Restoration.

IMPORTANT: Launch the rescue mode before using the 
Firmware Restoration utility.
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NOTE: 	 This is not a firmware upgrade utility and cannot be 
used on a working ASUS Wireless Router. Normal firmware 
upgrades must be done through the web interface. Refer to 
Chapter 3: Configuring via the web GUI for more details.

Download Master

Download Master is a utility that allows you to organize your 
HTTP, FTP, and BT (BitTorrent) download tasks.

Using the Download Master

NOTE:	 To use this feature, you need to plug a USB storage 
device, such as a USB hard disk or USB flash drive, to the USB 
2.0 port on the rear panel of your wireless router. Ensure that 
the USB storage device is formatted and partitioned properly. 
Refer to the ASUS website at http://www.asus.com for the 
HD file system support table.

To use the Download Master:
1.	Launch the Download Master from Start > All Programs 

> ASUS Utility > RT-N56U Wireless Router > Download 
Master. 

2.	Click File > Connect to connect to the wireless router.

5.	Specify a firmware file, then click Upload.
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3.	Follow the instructions below to organize the download tasks 
that you want to perform.

	

	 HTTP download
	  To perform an HTTP download, do any of the following:

		  •	�Right-click the download 
link on the web page and 
select Download using 
ASUS Download.

		  •	�Right-click the download 
link on the web page and 
select Properties. Copy 
the download Address 
(URL).

NOTES:

•	If you select Download using ASUS Download, you can 
see the download task is added to the Transfer list. The 
blue bars indicate the progress rate of the download tasks.

•	If you copy the download address, click the Assign button 
in the utility. Paste the address into Getting File From box, 
select HTTP from Options, and click the Download button 
to start.

•	Ensure that you safely remove the USB disk. Incorrect 
removal of the USB disk may cause data corruption.
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	 BT download
	 Save the BT seed on your 

computer. Click the Assign 
button of the Download 
Master and select BT in the 
Options field. Click Browser 
to locate the seed file and click 
Download to start.

FTP download
	 Click the Assign button of the 

Download Master and select 
FTP in the Options field. Key 
in the FTP site address, Port 
number, User Name, Password. 
Click Download to start.
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3.	Click the Folder button to view the download file. Open 
the Complete folder to view or copy the finished files to 
your local hard disk. The incomplete tasks are kept in the 
InComplete folder.
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5	 Troubleshooting

NOTE:	 If you encounter problems that are not mentioned in 
this chapter, contact the ASUS Technical Support.

Troubleshooting

I cannot access a web browser for configuring the router.
•	 Delete the cookies and files in your web browser. To do this, 

follow these steps:

	 1.	� Launch your web browser, then click Tools > Internet 
Options...

	 2.	� Under Temporary Internet files, click Delete Cookies... 
and Delete Files...

NOTE:	 The commands for deleting cookies and files vary 
with the web browser.

•	 Disable the proxy server settings, cancel the dial-up 
connection, and set the TCP/IP settings to obtain IP addresses 
automatically. For more details, refer to the section Before 
you proceed in this user manual.

The client cannot establish a wireless connection with  
the router.

Out of Range:
	 •	 Put the router closer to the wireless client.

	 •	 Try to change the channel settings.

Authentication:
	 •	 Use wired connection to connect to the router.

	 •	 Check the wireless security settings.

	 •	� Press the Reset button at the rear panel for more than five 
seconds.
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Cannot find the router:
	 •	� Press the Reset button at the rear panel for more than five 

seconds.

	 •	� Check the setting in the wireless adapter such as SSID and 
encryption settings.

Cannot access the Internet via wireless LAN adapter.
•	 Move the router closer to the wireless client.

•	 Check whether the wireless adapter is connected to the 
correct wireless router.

•	 Check whether the wireless channel in use conforms to the 
channels available in your country/area.

•	 Check the encryption settings.

•	 Check if the ADSL or Cable connection is correct.

•	 Retry using another Ethernet cable.

Internet is not accessible.
•	 Check the status indicators on the ADSL modem and the 

wireless router.

•	 Check if the WAN LED on the wireless router is ON. If the LED 
is not ON, change the cable and try again.

When ADSL Modem “Link” light is ON (not blinking), this 
means Internet Access is possible.
•	 Restart your computer.

•	 Refer to the Quick Start Guide of the wireless router and re-
configure the settings.

•	 Check if the WAN LED on the wireless router is ON.

•	 Check the wireless encryption settings.

•	 Check if the computer can get the IP address (via both wired 
network and wireless network).

•	 Ensure that your web browser is configured to use the local 
LAN, and is not configured to use a proxy server.
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If the ADSL “LINK” light blinks continuously or stays off, 
Internet access is not possible - the Router is unable to 
establish a connection with the ADSL network.
•	 Ensure that all your cables are all properly connected .

•	 Disconnect the power cord from the ADSL or cable modem, 
wait a few minutes, then reconnect the cord.

•	 If the ADSL light continues to blink or stays OFF, contact your 
ADSL service provider.

Network name or encryption keys are forgotten.
•	 Try setting up the wired connection and configuring the 

wireless encryption again.

 •	 Press the Reset button at the rear panel of the wireless router 
for more than five seconds.

How to restore the system to its default settings?
•	 Press the Reset button at the rear panel of the wireless router 

for more than five seconds.

•	 Refer to the section Restoring/Saving/Uploading settings 
in Chapter 3 of this user manual.

	 The following are the factory default settings:

		  User Name:	 admin 

		  Password:	 admin

		  Enable DHCP: 	 Yes (if WAN cable is plugged in)

		  IP address: 	 192.168.1.1

		  Domain Name: 	(Blank)

		  Subnet Mask: 	 255.255.255.0

		  DNS Server 1:	 192.168.1.1

		  DNS Server 2: 	 (Blank)

		  SSID:		  ASUS
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ASUS DDNS Service

RT-N56U supports the ASUS DDNS service. When exchanging 
devices at the service center, if you have registered the ASUS 
DDNS service and want to keep the original domain name, 
data transfer is a must. Visit your local service center for more 
information.

NOTES:

•	If there is no activity in the domain - such as reconfiguring 
the router or accessing the registered domain name - within 
90 days, the system automatically deletes the registered 
information. 

•	If you encounter any problem or difficulty in using your 
device, contact the service center.

Frequently Asked Questions (FAQs)

1.	Will the registered information be lost or registered by 
others?

	 If you have not updated the registered information in 
90 days, the system automatically deletes the registered 
information and the domain name may be registered by 
others.

2.	I did not register the ASUS DDNS for the router I 
bought six months ago. Can I still register it?

	 Yes, you can still register the ASUS DDNS service for your 
router. The DDNS service is embedded in your router, so 
you can register the ASUS DDNS service anytime. Before 
registering, click Query to check if the hostname has been 
registered or not. If not, the system registers the hostname 
automatically.
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3.	I have registered a domain name before and it has been 
working well until my friends told me that they could 
not access my domain name.

	 Check the following:

		  1.   The internet is working well.

		  2.   The DNS server is working well.

		  3.   The last time you updated the domain name.

	 If there are still problems in accessing your domain name, 
contact the service center.

4.	Can I register two domain names to separately access 
my http and ftp servers?

	 No, you cannot. You can only register one domain name for 
one router. Use port mapping to implement security in the 
network.

5.	After restarting the router, why is it that I see different 
WAN IPs in MS DOS and in the router configuration 
page?

	 This is normal. The interval time between the ISP DNS server 
and ASUS DDNS results in different WAN IPs in MS DOS and 
in the router configuration page. Different ISPs may have 
different interval time for IP updating.

6.	Is the ASUS DDNS service free, or is it just a trial 
version?

	 The ASUS DDNS service is a free and embedded service in 
some ASUS routers. Check your ASUS router if it supports the 
ASUS DDNS service.
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Appendices
Notices

ASUS Recycling/Takeback Services

ASUS recycling and takeback programs come from our 
commitment to the highest standards for protecting our 
environment. We believe in providing solutions for you to 
be able to responsibly recycle our products, batteries, other 
components, as well as the packaging materials. Please go 
to http://csr.asus.com/english/Takeback.htm for the detailed 
recycling information in different regions.

REACH

Complying with the REACH (Registration, Evaluation, 
Authorisation, and Restriction of Chemicals) regulatory 
framework, we published the chemical substances in our 
products at ASUS REACH website at
http://csr.asus.com/english/index.aspx

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: 
•	 This device may not cause harmful interference.

•	 This device must accept any interference received, including 
interference that may cause undesired operation.

This equipment has been tested and found to comply with the 
limits for a class B digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
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Prohibition of Co-location

This device and its antenna(s) must not be co-located or 
operating in conjunction with any other antenna or transmitter

Caution: Any changes or modifications not expressly 
approved by the party responsible for compliance could void 
the user’s authority to operate the equipment.

IMPORTANT!	 This device within the 5.15 ~ 5.25 GHz is 
restricted to indoor operations to reduce any potential for 
harmful interference to co-channel MSS operations.

protection against harmful interference in a residential 
installation.
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the equipment and receiver.

•	 Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected.

•	 Consult the dealer or an experienced radio/TV technician for 
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Safety Information

To maintain compliance with FCC’s RF exposure guidelines, this 
equipment should be installed and operated with minimum 
distance 20cm between the radiator and your body. Use on the 
supplied antenna.

Declaration of Conformity for R&TTE directive 1999/5/
EC

Essential requirements – Article 3
Protection requirements for health and safety – Article 3.1a
Testing for electric safety according to EN 60950-1 has been 
conducted. These are considered relevant and sufficient.
Protection requirements for electromagnetic compatibility 
– Article 3.1b
Testing for electromagnetic compatibility according to EN 301 
489-1 and EN 301 489-17 has been conducted. These are 
considered relevant and sufficient.
Effective use of the radio spectrum – Article 3.2
Testing for radio test suites according to EN 300 328- 2 has 
been conducted. These are considered relevant and sufficient.

CE Mark Warning

This is a Class B product, in a domestic environment, this 
product may cause radio interference, in which case the user 
may be required to take adequate measures.
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NCC 警語

經型式認證合格之低功率射頻電機，非經許可，公司、商號或
使用者均不得擅自變更頻率、

加大功率或變更原設計之特性及功能。

低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經
發現有干擾現象時，應立即

停用，並改善至無干擾時方得繼續使用。

前項合法通信，指依電信法規定作業之無線電通信。

低功率射頻電機須忍受合法通信或工業、科學及醫療用電波輻
射性電機設備之干擾。

GNU General Public License

Licensing information

This product includes copyrighted third-party software licensed 
under the terms of the GNU General Public License. Please 
see The GNU General Public License for the exact terms and 
conditions of this license. We include a copy of the GPL with 
every CD shipped with our product. All future firmware updates 
will also be accompanied with their respective source code. 
Please visit our web site for updated information. Note that we 
do not offer direct support for the distribution.

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of 
this license document, but changing it is not allowed.
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Preamble

The licenses for most software are designed to take away your 
freedom to share and change it. By contrast, the GNU General 
Public License is intended to guarantee your freedom to share 
and change free software--to make sure the software is free for 
all its users. This General Public License applies to most of the 
Free Software Foundation’s software and to any other program 
whose authors commit to using it. (Some other Free Software 
Foundation software is covered by the GNU Library General 
Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, 
not price. Our General Public Licenses are designed to make sure 
that you have the freedom to distribute copies of free software 
(and charge for this service if you wish), that you receive source 
code or can get it if you want it, that you can change the 
software or use pieces of it in new free programs; and that you 
know you can do these things.
To protect your rights, we need to make restrictions that forbid 
anyone to deny you these rights or to ask you to surrender the 
rights. These restrictions translate to certain responsibilities for 
you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether 
gratis or for a fee, you must give the recipients all the rights that 
you have. You must make sure that they, too, receive or can get 
the source code. And you must show them these terms so they 
know their rights.
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We protect your rights with two steps: (1) copyright the 
software, and (2) offer you this license which gives you legal 
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make 
certain that everyone understands that there is no warranty for 
this free software. If the software is modified by someone else 
and passed on, we want its recipients to know that what they 
have is not the original, so that any problems introduced by 
others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software 
patents. We wish to avoid the danger that redistributors of a 
free program will individually obtain patent licenses, in effect 
making the program proprietary. To prevent this, we have made 
it clear that any patent must be licensed for everyone’s free use 
or not licensed at all.
The precise terms and conditions for copying, distribution and 
modification follow.

Terms & conditions for copying, distribution, & 
modification
0.	This License applies to any program or other work which 

contains a notice placed by the copyright holder saying it 
may be distributed under the terms of this General Public 
License. The “Program”, below, refers to any such program 
or work, and a “work based on the Program” means either 
the Program or any derivative work under copyright law: 
that is to say, a work containing the Program or a portion 
of it, either verbatim or with modifications and/or translated 
into another language. (Hereinafter, translation is included 
without limitation in the term “modification”.) Each licensee 
is addressed as “you”.
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	 Activities other than copying, distribution and modification 
are not covered by this License; they are outside its scope. 
The act of running the Program is not restricted, and the 
output from the Program is covered only if its contents 
constitute a work based on the Program (independent of 
having been made by running the Program). Whether that is 
true depends on what the Program does.

1. 	You may copy and distribute verbatim copies of the Program’s 
source code as you receive it, in any medium, provided that 
you conspicuously and appropriately publish on each copy 
an appropriate copyright notice and disclaimer of warranty; 
keep intact all the notices that refer to this License and to the 
absence of any warranty; and give any other recipients of the 
Program a copy of this License along with the Program.

	 You may charge a fee for the physical act of transferring a 
copy, and you may at your option offer warranty protection in 
exchange for a fee.

2.	You may modify your copy or copies of the Program or any 
portion of it, thus forming a work based on the Program, and 
copy and distribute such modifications or work under the 
terms of Section 1 above, provided that you also meet all of 
these conditions:

	 a)	 You must cause the modified files to carry prominent 
notices stating that 	you changed the files and the date of 
any change.

	 b)	 You must cause any work that you distribute or publish, 
that in whole or in 	 part contains or is derived from the 
Program or any part thereof, to be licensed as a whole at no 
charge to all third parties under the terms of this License.

	 c) If the modified program normally reads commands 
interactively when run, you must cause it, when started 
running for such interactive use in the most ordinary way, to 
print or display an announcement including an appropriate 
copyright notice and a notice that there is no warranty (or 
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else, saying that you provide a warranty) and that users may 
redistribute the program under these conditions, and telling 
the user how to view a copy of this License. (Exception: if the 
Program itself is interactive but does not normally print such 
an announcement, your work based on the Program is not 
required to print an announcement.)

	 These requirements apply to the modified work as a whole. 
If identifiable sections of that work are not derived from the 
Program, and can be reasonably considered independent and 
separate works in themselves, then this License, and its terms, 
do not apply to those sections when you distribute them as 
separate works. But when you distribute the same sections 
as part of a whole which is a work based on the Program, 
the distribution of the whole must be on the terms of this 
License, whose permissions for other licensees extend to the 
entire whole, and thus to each and every part regardless of 
who wrote it.

	 Thus, it is not the intent of this section to claim rights or 
contest your rights to work written entirely by you; rather, 
the intent is to exercise the right to control the distribution of 
derivative or collective works based on the Program.

	 In addition, mere aggregation of another work not based on 
the Program with the Program (or with a work based on the 
Program) on a volume of a storage or distribution medium 
does not bring the other work under the scope of this 
License.

3.	You may copy and distribute the Program (or a work based 
on it, under Section 2) in object code or executable form 
under the terms of Sections 1 and 2 above provided that you 
also do one of the following:

	 a)	 Accompany it with the complete corresponding machine-
readable source code, which must be distributed under the 
terms of Sections 1 and 2 above on a medium customarily 
used for software interchange; or,
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	 b)	 Accompany it with a written offer, valid for at least three 
years, to give any third party, for a charge no more than your 
cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to 
be distributed under the terms of Sections 1 and 2 above on 
a medium customarily used for software interchange; or,

c)	 Accompany it with the information you received as to 
the offer to distribute corresponding source code. (This 
alternative is allowed only for noncommercial distribution and 
only if you received the program in object code or executable 
form with such an offer, in accord with Subsection b above.)

	 The source code for a work means the preferred form of 
the work for making modifications to it. For an executable 
work, complete source code means all the source code 
for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation 
and installation of the executable. However, as a special 
exception, the source code distributed need not include 
anything that is normally distributed (in either source or 
binary form) with the major components (compiler, kernel, 
and so on) of the operating system on which the executable 
runs, unless that component itself accompanies the 
executable.

	 If distribution of executable or object code is made by 
offering access to copy from a designated place, then 
offering equivalent access to copy the source code from the 
same place counts as distribution of the source code, even 
though third parties are not compelled to copy the source 
along with the object code.

4.	You may not copy, modify, sublicense, or distribute the 
Program except as expressly provided under this License. Any 
attempt otherwise to copy, modify, sublicense or distribute 
the Program is void, and will automatically terminate your 
rights under this License. However, parties who have received 
copies, or rights, from you under this License will not have 
their licenses terminated so long as such parties remain in full 
compliance.
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5.	You are not required to accept this License, since you have 
not signed it. However, nothing else grants you permission 
to modify or distribute the Program or its derivative works. 
These actions are prohibited by law if you do not accept this 
License. Therefore, by modifying or distributing the Program 
(or any work based on the Program), you indicate your 
acceptance of this License to do so, and all its terms and 
conditions for copying, distributing or modifying the Program 
or works based on it.

6.	Each time you redistribute the Program (or any work based 
on the Program), the recipient automatically receives a license 
from the original licensor to copy, distribute or modify the 
Program subject to these terms and conditions. You may not 
impose any further restrictions on the recipients’ exercise 
of the rights granted herein. You are not responsible for 
enforcing compliance by third parties to this License.

7.	 If, as a consequence of a court judgment or allegation of 
patent infringement or for any other reason (not limited to 
patent issues), conditions are imposed on you (whether by 
court order, agreement or otherwise) that contradict the 
conditions of this License, they do not excuse you from the 
conditions of this License. If you cannot distribute so as to 
satisfy simultaneously your obligations under this License and 
any other pertinent obligations, then as a consequence you 
may not distribute the Program at all. For example, if a patent 
license would not permit royalty-free redistribution of the 
Program by all those who receive copies directly or indirectly 
through you, then the only way you could satisfy both it and 
this License would be to refrain entirely from distribution of 
the Program.

	 If any portion of this section is held invalid or unenforceable 
under any particular circumstance, the balance of the section 
is intended to apply and the section as a whole is intended to 
apply in other circumstances.

	 It is not the purpose of this section to induce you to infringe 
any patents or other property right claims or to contest 



67

validity of any such claims; this section has the sole purpose 
of protecting the integrity of the free software distribution 
system, which is implemented by public license practices. 
Many people have made generous contributions to the 
wide range of software distributed through that system in 
reliance on consistent application of that system; it is up to 
the author/donor to decide if he or she is willing to distribute 
software through any other system and a licensee cannot 
impose that choice.

	 This section is intended to make thoroughly clear what is 
believed to be a consequence of the rest of this License.

8.	 If the distribution and/or use of the Program is restricted 
in certain countries either by patents or by copyrighted 
interfaces, the original copyright holder who places the 
Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that 
distribution is permitted only in or among countries not thus 
excluded. In such case, this License incorporates the limitation 
as if written in the body of this License.

9.	The Free Software Foundation may publish revised and/or 
new versions of the General Public License from time to 
time. Such new versions will be similar in spirit to the present 
version, but may differ in detail to address new problems or 
concerns.

	 Each version is given a distinguishing version number. If the 
Program specifies a version number of this License which 
applies to it and “any later version”, you have the option 
of following the terms and conditions either of that version 
or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number 
of this License, you may choose any version ever published by 
the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other 
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free programs whose distribution conditions are different, 
write to the author to ask for permission.

	 For software which is copyrighted by the Free Software 
Foundation, write to the Free Software Foundation; we 
sometimes make exceptions for this. Our decision will be 
guided by the two goals of preserving the free status of all 
derivatives of our free software and of promoting the sharing 
and reuse of software generally.

NO WARRANTY
11	BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, 

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE 
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 
AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE PROGRAM IS WITH YOU. 
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 
THE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION.

12	IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR 
AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, 
OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF 
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), 
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.
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ASUS Contact information

ASUSTeK COMPUTER INC. (Asia Pacific)
Address	 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Website	 www.asus.com.tw

Technical Support
Telephone	 +886228943447
Support Fax	 +886228907698
Online support	 support.asus.com

ASUS COMPUTER INTERNATIONAL (America)
Address	 800 Corporate Way, Fremont, CA 94539, USA
Telephone	 +15107393777
Fax		 +15106084555
Website	 usa.asus.com
Online support	 support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)
Address	 Harkort Str. 21-23, D-40880 Ratingen, Germany
Telephone	 +491805010923*
Fax		 +492102959911
Website	 www.asus.de
Online contact	 www.asus.de/sales

Technical Support
Telephone (Component, Networking)	 +491805010923*
Telephone (System/Notebook/Eee/LCD)	 +491805010920*
Fax					    +492102959911
Online support				    support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile phone.
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Area Hotline Number Support  
Languages

Working 
Hour

Working 
Day

Australia 1300-2787-88 English 9:00-18:00 Mon. to 
Fri.

Austria 0043-820240513 German 9:00-18:00 Mon. to 
Fri.

Belgium 0032-78150231 Dutch /French 9:00-17:00 Mon. to 
Fri.

China 800-820-6655; 
021-34074610

Simplified 
Chinese 9:00-18:00 Mon. to 

Sun.

Denmark 0045-3832-2943 Denish/English 9:00-17:00 Mon. to 
Fri.

Finland 00358-9693-7969 Finnish/English/
Swedish 10:00-18:00 Mon. to 

Fri.

France 0033-170949400 France 9:00-17:45 Mon. to 
Fri.

Greece 00800-44-14-20-44 Greek 9:00-13:00; 
14:00-18:00

Mon. to 
Fri.

Hong Kong 3582-4770 
Cantonese/ 
Chinese/ 
English

10:00-20:00
Mon. to 
Fri.

10:00-17:00 Sat.

Ireland 0035-31890719918 English 9:00-17:00 Mon. to 
Fri.

Japan 0800-123-2787 Japanese
9:00-18:00 Mon. to 

Fri.

9:00-17:00 Sat. to 
Sun.

Malaysia

+603 2148 0827 
(Check Repair Detail 
Status Only)
+603-6279-5077

Bahasa Melayu/
English 10:00-19:00 Mon. to 

Fri.

Netherlands 
 / Luxembourg 0031-591-570290 Dutch / English 9:00-17:00 Mon. to 

Fri.

New Zealand 0800-278-788 / 
0800-278-778 English 9:00-17:00 Mon. to 

Fri.

Norway 0047-2316-2682 Norwegian 
/English 9:00-17:00 Mon. to 

Fri.

Philippine +632-636 8504; 
180014410573 English 9:00-18:00 Mon. to 

Fri.

Poland
00225-718-033
00225-718-040

Polish
9:00-17:00
8:30-17:30

Mon. to 
Fri.

Portugal 707-500-310 Portuguese 9:00-17:00 Mon. to 
Fri.

Networks Global Hotline Information
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Area Hotline Number Support  
Languages

Working 
Hour

Working 
Day

Russia +8-800-100-ASUS; 
+7-495-231-1999

Russian/ 
English 9:00-18:00 Mon. to 

Fri.

Singapore
+65-6720-3835 
(Check Repair Detail 
Status Only)
-66221701

English
11:00-19:00 Mon. to 

Fri.

Slovak 00421-232-162-621 Czech 8:00-17:00 Mon. to 
Fri.

Spain 902-88-96-88 Spanish 9:00-18:00 Mon. to 
Fri.

Sweden 0046-8587-6940 Swedish/ 
English 9:00-17:00 Mon. to 

Fri.

Switzerland

0041-848111010 German/French 9:00-18:00 Mon. to 
Fri.

0041-848111014 French 9:00-17:45 Mon. to 
Fri.

0041-848111012 Italian 9:00-17:00 Mon. to 
Fri.

Taiwan 0800-093-456; 
02-81439000

Traditional 
Chinese 

9:00-12:00; 
13:30-18:00

Mon. to 
Fri.

Thailand +662-679-8367 -70; 
001 800 852 5201 Thai/English 9:00-18:00 Mon. to 

Fri.

Turkey +90-216-524-3000 Turkish 09:00-18:00 Mon. to Fri

United Kingdom 0044-870-1208340; 
0035-31890719918 English 9:00-17:00 Mon. to 

Fri.

USA/Canada 1-812-282-2787 English

8:30-
12:00am 
EST
(5:30am-
9:00pm PST)

Mon. to 
Fri.

9:00am-
6:00pm EST
(6:00am-
3:00pm PST)

Sat. to 
Sun.

Networks Global Hotline Information

NOTE:	 For more information, visit the ASUS support site at: 
http://support.asus.com
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Manufacturer: ASUSTeK Computer Inc.
Tel: +886-2-2894-3447
Address: No. 150, LI-TE RD., PEITOU, 

TAIPEI 112, TAIWAN
Authorised 
representative  
in Europe:

ASUS Computer GmbH
Address: HARKORT STR. 21-23, 40880 

RATINGEN, GERMANY
Authorised 
distributors  
in Turkey:

BOGAZICI BIL GISAYAR SAN. VE TIC. 
A.S.
Tel: +90 212 3311000
Address: AYAZAGA MAH. 

KEMERBURGAZ CAD. NO.10 
AYAZAGA/ISTANBUL

CIZGI Elektronik San. Tic. Ltd. Sti.

Tel: +90 212 3567070
Address: CEMAL SURURI CD. HALIM 

MERIC IS MERKEZI 
No: 15/C D:5-6 34394 
MECIDIYEKOY/ISTANBUL

EEE Yönetmeliğine Uygundur.


	1	A quick look
	Package contents
	Your wireless router
	Mounting placement

	2	Creating your network
	Positioning your router
	What you need
	Setting up your wireless router
	Wired connection
	Wireless connection

	Before you proceed
	A.	Disable the proxy server, if enabled.
	B.	�Set the TCP/IP settings to automatically obtain an IP address.
	C.	Disable the dial-up connection, if enabled.


	3	�Configuring via the web GUI
	Logging into the web GUI
	Setting up the Internet connection
	Quick Internet Setup (QIS) with auto-detection
	Using Wi-Fi Protected Setup (WPS)

	Setting up the wireless security settings
	Managing your network clients
	Monitoring your USB device
	Using your router as a UPnP Media Server
	Using AiDisk for an FTP Server and Network Neighborhood setup
	Managing EZQoS Bandwidth
	Configuring the Advanced settings
	Setting up the DHCP Server
	Upgrading the firmware
	Restoring/Saving/Uploading settings
	Sharing files from a USB storage device

	Setting up your network printer

	4	Using the utilities
	Device Discovery
	Firmware Restoration
	Download Master

	5	Troubleshooting
	Troubleshooting
	ASUS DDNS Service
	Frequently Asked Questions (FAQs)


	Appendices
	Notices
	ASUS Contact information
	Networks Global Hotline Information


